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“You can’t think

sajgno.tj 1noAk jnogn

Y solving a crossword.”
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hen Arthur W_}flm(’ created the first

crossword puzzle (or word-cross as
he called it) for the Christmas 1913 edition
ol the New York World, he couldn’t have
known the impact his inspiration would
have on society. After almaost 80 years the
crossword phenomenon hasn’t faltered.
In fact, the crossword’s popularity has in-
spired hoard games, television shows, and
other more (and less) sophisticated word
puzzles. In spite of these competitors, the
classic erossword puzzle still remains the
#1 form of indoor entertainment.

Beecause of the popularity and growing
ease-of-use offered by modern personal
computers, it became evident that it was
finally time to merge crossword puzzles
with this technology that has rapidly be-
come such a large part of our lives. The
initial challenge was to find a way to make
the computerized crossword experience as
accessible and easy-to-use as classic paper
and pencil crossword puzzles. Sierra’s
Takeed®Break! line provided the perlect
opportunity. An entire software line dedi-
cated to games vou can jump into any-
time you need a quick break from work.
screaming children, or the evervday
insanity that imposes upon all our lives.

The next hurdle was how to make cross-
words even better on the computer than

on paper. After significant research and

design, we camne up with several features
that we think make TakesAeBreak!

Crosswords easier and more fun to use
than traditional crosswords, Features like
an option that tells vou immediately if an
answer is right or wrong and one that au-
tomatically highlights the word yvou're
working on so you don’t lase vour place.
You can get a hint without waiting until
fomorrow’'s newspaper or customize the
look of the puzzles to suit your taste. You
can also keep score and play timed games
in order to compete with vour friends and
family. TakesAeBreak! Crossicords even
congratulates you with an animation and
a thought provoking quote when vou
finish a puzzle—try to get vour Sunday
paper to do that!

TakesAeBreak! Crosswords provides you
with an original music soundtrack that
merges modern jazz and rock & roll with
a classical, Bach-like feeling. Last, but
not least, we've included a charming
animated tour guide to the land of
Crossivords—Wanda the Word Fairy.

But that's enough from us, on to
more important business: playing
TakesAoBreak! Crosswords! Have
[un taking a breal!!



he first newspaper in the United States to include crossword puzzles as a daily

feature was The New York World. Their first daily puzzle appeared on

November 24, 1924 and was composed by none other than Gelett Burgess, the author

of the following famous ditty: “I never saw o Purple Cow, | never hope fo see one;

But | can tell you, anyhow, I'd rather see than be one”

Crosswords, or Word-Cross puzzles, as
g, had
humble origins. Arthur Wynne of the New

they were known in the beginnin

York World was searching for a new type
of puzzle for the Christmas 1913 edition
of the World’s Sunday supplement.
Rebuses, hidden words and anagrams
were the usual fare, but he wanted some-
thing special. Plaving with traditional
word puzzles, he stumbled upon the idea
of the word-cross puzzle.

Wynne’s puzzle began a phenomenon
that persists even today. From its first
appearance, people were crazy for the
crossword. When the puzzle was dropped
from the paper one Sunday, the Forld
was overrun with mmplaims {rom its
-x‘éadcrs. With time, the crossword puzzle

developed its familiar square grid with an

'56ddgmlmher of squares in all rows and

tolumns. It beeame universally accepted
that the diagram should be a mirror
image of itself if divided diagonally
(it should look the same il turned upside
down) and that all words must interlock.
The reasons behind the mirror-like sym-
metry of the puzzle are unclear, although
the legendary puzzle editor, Margaret

Farrar, was reputed to have said that the
puzzle has adopted this form “because it
is prettier.”

Over the next ten years the crossword
puzzle craze continued to grow. While the
World was the first newspaper to get into
the act, Simon and Schuster came out
with the first book of crosswords in
January 1924, Initially mocked by their
peers in the publishing field, they pub-
lished the book under the pseudonym,
The Plaza Publishing Company. Within
a day ol publication, however, no one
was laughing as orders for the book
poured in. One year later the company
had published three volumes of puzzles
with record breaking (for 1924) sales of
over 400,000 copies.

Crossword puzzle mania was here to stay,
Couples composed crosswords announc-
ing their engagement. Churches got into
the act using crosswords to attract more
people to services. Even the fashion in-
custry was bitten by the crossword bug,
In 1925 the industry reported an in-
creased demand for checked fabric, One
New York dress manufacturer even came
out with a line of dresses embroidered

Continued on page 6



The Weorld’s First Crossword

l';(iﬂ'.‘f.’.‘.‘{"’?" on page (),)

Recreated from the original. f vln
2 3
4 5
32
-] 9
T
10 13
11 12
14 15 I | 16 17
19 20
18 21
23 |_| 24
22 25
33
27
29
31
34

23,

4-5.

6-7.
10-11.
14-15.
18-19.
22-23.
26-27.
28-29.
30-31.

12:13:
16-17.
20-21.
24-25.
10-18.

Whal bargain hunters enjoy.
A written acknowledgement.
Such and nething more.

A bird,

Opposed to less.

What this puzzle is.

An animal of prey.

The close of ¢ day.

To elude.

The plural of is.

To cultivate.

A bar of wood or iron.
What artists lzarn fo do.
Fastened.

Found on the seashore.

The fibre of the gemuti palm.

6-22.  What we all should be.

4-26. A day dream,
2-11.  Atclon.

19-28. A pigeon.

7. Partof your head.

23-30.  Acriver in Russia,

1-32.  To govern.

33-34.  An aromatic plant.

n-8. Afist,

24-31. Toagree with,

3-12.  Partotaship.

20-29.  One.

5-27. Ex(:hunging.
9-25.  Tosinkin mud.

13-21.  Aboy.




HISTORY AND TRIVIA

with puzzle squares. Each dress came with
a book of puzzles that, if returned to the
company correctly solved, earned the fash-
ionable puzzler a discount on other cloth-
ing in the line.

The play, Puzszles of 1925, featured the
patients of a mental hospital solving eross-
word puzzles and became a Broadway hit
in the 1920s. Another hit was Tell Me
More! a Broadway musical that contains
the line, “I hope vou're stranded on a
desert island with a crossword puzzle and
without a dictionary.” A popular song of
the day was “Crossword Mama You Puzzle
Me (But Papa’s Gonna Figure You Out).”

Sometimes crossword mania took on
strange and disturbing forms, An under-
taker’s trade journal featured a crossword
it their June 1925 issue that contained sci-
entific and technical terms about funerals
and embalming. A man named Theadore
Koerner shot his wife for refusing to help
him with a puzzle and then killed himsell.
{She survived the attack.) A waiter
[rom Budapest killed himsell in
19206, leaving behind a sui-
cide note in the form of

a crossword

puzzle. The police were forced to call in
puzzle experts to help them solve it.
Perhaps as a response to these unusual
events, Gelett Burgess was inspired to put
pen to paper once more:

The fans they chew their pencils,

The fans they beat their wives.

They look up words for extinct birds—
They lead such puzzling lives!

Watching the phenomenon from abroad.
The Times newspaper in London pooh-
poohed America’s fascination with eross-
word puzzles. Featured under the headline
“AN ENSLAVED AMERICA™ an article
tated: “All America has

about puzzling
succumbed to the crossword puzzle.” Not
two months later the Times was forced 1o
cat those words when it realized that
Britain, too. was enamored with the cross-
word puzzle. The Times veferred to its
“Iinslaved America” article when it stated,
“The aceount was hardly printed hefore
the craze had crossed the Atlantic with the
speed of a meteorological depression. The
nation stands hefare the blast and no man

can say it will stand erect again.”

Fortunately, not everyone took such a dim
view of puzzling. In January 1932, The
Neiw York Times was pleased to report that
Buckingham Palace had issued a statement
that Queen Mary was a crossword enthusi-
ast. The Prime Minister of England also
turned ont to be a puzzler. He praised the
crossword puzzle in a speech at a Press

Club luncheon and stated that the press




was bettering the common
people “through that marvelous
medium, the erossword puzzle.”

George Dellacourte began his legendary
Dell Crossword Puzzle Magazine in 1931,
The cceentric New York benefactor left a

legacy that includes 34 monthly puzzle
magazines published in all English-speak-
ing countries. A familiar sight to New
Yorkers, Dellacourte could often be seen
sporting a floppy hat and a long flowing
cape. During his lifetime Dellacourte
donated great sums of money to various
deserving New York charities. His only
requirement was that his gift be acknowl-
edged by displaying his name in a promi-
nenl public place. Today, statues and
plaques to Dellacourte abound in New
York city.

Crossword madness continued into the
Farties and Filties. The New York Times
began publishing its now-famous Sunday
stumper on a regular basis in 1942, The
smaller. easier daily puzzles became a regu-
lar feature in the 19507,

In 1944, the chief compiler [or the London
Daily Telegraph, Leonard Sidney Dawe,
came under close serutiny from British in-
tel ligenece of ficers when his puzzles started
containing solutions that matched secret
code names for landing beaches in the up-
coming invasion of Normandy! Somehow
Dawe convineed the military that it was all
a fantastic coincidence.

In mare recent crossword history, Merl
Regale, whose puzales regularly appear

in the Sun Francisco Lxaminer, composed
a special puzzle for a loval fan, Neil
Nathanson. The puzzle. which appeared
in the Sunday Eraminer in November
1991, contained a marriage proposal
from Neil to his beloved, Leslic Hamilton
—Dear Leslie, will you marry me? Neil.”

The First Lady of Crosswords

Fresh from Smith College in 1020,
Margaret Petherbridge’s first job was ._
secretary o the editor of the New York

World’s magazine section. Among other

things, her duties included making sure
that the weekly crossword puzzles ap-
peared without typographical errors.
Petherbridge was so adept at spotiing
mistakes that she became the unofficial
crossword editor, When Simon and
Schuster published their [irst puzzle book

they sought out Petherbridge’s expertise

and she worked as their editor as well.
She became Margaret Farrarin 1920,
alter her marriage to publisher John
Farrar, In 1970, she celebrated the 100th
volume of Simon and Schuster eross-
words under her editorship. When the
New Fork Times began offering regular

puzzles in 1942, they. too. hired Margaret

Farrar as their puzzle editor.

As the undisputed “Queen of Puzzle-
dom,” Farrar’s career has been long and
distinguished. While compiling 4 hook of
crosswords by eelebrities early in her ca-




HISTORY AND TRIVIA

reer with Simon and Schuster, she received
the following reply to a request for a sub-
mission from playwright and novelist Booth
l'arkington:

Vo ddear Miss Petherbridge:

! fictee liad traclide enongl with vorr o

hools: and if Twere ale to budd o cross-
H'ru'r.’l;.l.r.r:.::f{', [ e too Lincd-hearted to do it
] r’ur'.'n_r{g;"ff.'.n"rfr’ setl me L’Jvﬂr:s‘.’ t'iwn"\'_;'u.w'
as [ iras abont to do some averdie work.
Thew, o weeks latee when had just fin-
ished vour first buok. e sent me the sce

b o0l thoueh Dhad weitten him. beeeting

fiine vioi 1o do i,

Ihen } wef ff.wmfw; a"ffr;pr werer fo
frear .r.'a'rl‘.'f!fr.r.ilg' more ahopt prusz
qf'm.r_ v keined.

Melignanthv Yonrs,

Bootl Tarkington

Farrar once received a

call from a student at

Columbia University
asking for help on
that dav’s cross-
word as it was

da] IT'{.‘l'l?E.I 11i-

site for admission in a certain campus
fraternity. She recognized the ethical
dilemma but threw him a few hints and
hoped for the best.

Farrar established her own eriteria for
what made an acceptable puzzle. Her
most important requisite was that the
solver must enjoy working the puzzle.
Though erossword aficionados still quib-
ble about the details, Farrar's eriteria still
stand as a guide for puzzle designers to-
day. According to Farrar’s guidelines, all
parts of the puzzle must connect with all
other parts with no unchecked letters.
Black squares can account for no more
than 1/0 of the total squares in a puzzle.
She did not allow two-letter words and
preferved puzzles with a low word count

as they were more diflicult to -ofwi _
Finally, elichéd words (those cuire | liter-
ally done to death in erossword puzzles

over the vears] like “gnu™ are 1o be
avoided as are obscure foreign words and

inelegant abbreviations.

Successors to the Throne

Moargaret Farrar was succeeded at The
New York Times in 1969 by Will Weng,
former head of the Times merropolitan
copy desk. While serving as puzzle editor
he popularized a new sort of puzzle with
a humorous bent. An avid punster, Weng
accepted many puzzles with elues or solu-
tions that formed hnunorous puns. In one

of Weng's own puzzles the clue: “Is vour



doctor influential?” resulted in the answer Dr. Eugene Maleska, poet and former su-
“NO BUT MY DENTIST HAS A PULL.” perintendent of east Bronx schools in New
Sometimes the puns or ghmmicks weren’t York, succeeded Weng in 1977, Maleska
50 obvious and resulted in much com- continues Weng's humorous puzzle legacy
plaining from disgruntled readers. For in- and has introduced some of his own puz-
stance, the simple clue "AVI™ led to the zle inventions incorporating famous
answer: “THE CENTER OF GRAVITY™ quotes, He is also responsible for repopu-
and howls of protest from many puzzlers. larizing the cryptic erossword in the

United States.

Solution to puzzle on page 5
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Installation
1. Enter Windows by typing “WIN” at the
DOS prompt.

2. Insert the original TakeedeBreak!

Crosswords disk in a floppy disk drive.

3. In the Program Manager, select Run
from the File pulldown menu.

4. Type the letter of the [loppy disk drive
containing the Crosswords diskette lol-
lowed by the command “ASETUP™ then
press [Enter] or click the [OK] button.

Example: AASETUDP [Enter]

5. The Setup program will ask vou into
which hard drive and subdirectory you

wish to place the Crosswords game.

&. After you have indicated which hard
drive you want to install the game on, click
[OK]. The program will check for suffi-
cient storage space. If space is available,
the installation process will take from one
to five minutes depending upon the speed
of vour computer and hard drive.

7. Now you are ready to play.
Double-click aon the Sierra
group icon, then double-
click on the
Crosswords icon.
Enjoy the

game!

The File menu

Open

Select Open to play a new puzzle, If vou
are currently playing a puzzle when you
select the Open command. vou will be
asked if you wish to save the current puz-
zle before loading a new one.

I'rom the Puzzle Selection window you
can select puzzles of varying size and dif-
ficulty. Seroll through the list of available
puzzles and highlight the one you wish to
play. Click on the Play Blank Puzzle
button on the bottom of the window (o
select the highlighted choice. To restore a
puzzle saved in progress click on the Play
Restored Puzzle button,

Clear/Restart
Restarts a puzzle from the beginning.
Werning!! This will completely clear all

vour work in progress!

Restore
Choose Restore from the File menu to
play a previously saved puzzle.

Save
Saves a puzzle in progress.

Print

Prints a puzzle in progress. Crosswords
recuires a graphics-capable, Windows-
compatible printer such as a dot-matrix,
thermal, ink jet or laser printer. Non-
graphics printers will not work.

Exit
Exits the game to Windows.



The Options menu
The Options menu includes several fea-
tnres to tailor Crosswords to vour prefer-

ENCes,

Undo

Undo will restore the current word to
what it was belore you started typing. No
scoring penalties will be deducted if vou
select Undo and choose a different ward,

Colors

Customize the colors of your puzzle
screen. There are several dillerent tiles
with corresponding Across and Down
placards.

Avtacheck Word

Autocheck gives the novice-puzzler im-
mechiate notification of whether an an-
swer is correet. I an answer is wrong, the
computer will erase the incorrect answer
and allow vou to try again. Il an answer is
correct, the word-highlight bar will ad-
vance to the next ineomplete or wrong
answer, Nole: Scoring options and sound
effects are disabled when Autocheck is
turned off.

Auto-Lefter Advance

Auto-Letter Advance selects the next
blank letter when vou are typing in an
answer. This allows vou to type in words

without retyping already solved letters.

Interconnecting Clue Highlight

This feature highlights entries in the clue
list related to the current letter position.
For example, if the third letter of

1-Across is highlighted and this also
happens to be the first letter of 3-Down,
the 1-Across and 3-Down clues will both
be highlighted in the clue lists.

Clack

Timed gameplay can be turned on or off.
Completion dme is alwavs displaved dur-
ing the congratulations sereen, regardless
of the clock setting.

256 Color Artwork

Select berween standard 16-color arcwork
and enhanced 256-color artwork for
computers that can display 256 color
graphics. You must restart the game from
Windows to see changes to the graphics

mode.

Wanda’s Head

Hides the animation of Wanda the Word
Fairy’s head which appears at the top of
VOUT Sereen, The option is on il a check

mark appears beside it.

Wanda’s Placards

Seleet alternate placards which may be
more appropriate for the work environ-
ment with this option. An example of the
placards will appear as the heading for
the Display Score option.

Animations .
Turn off the congratulations animations
displayed when you complete a puzzle.
You will still get the congratulations mes-
sage, quote, and score breakdown when
vou finish a puzzle.




The Skill m
The Skill menu offers three levels of

o

crossword challenge. The level you
choose adjusts “handicap” features to

make your Crosswords experience more

challenging.

Apprentice

This is the easiest skill level. Hints and
Autocheek are available to vou.
Puzzler

As a Puzzler, you don’t have access to
Hints. You do have the option to use
Autocheck.

Fanatic
For Fanatic puzzlers, Hints and Auto-

check are not available. Purists can mea-

sure their personal best by cheeking the
Wrong Answer Penalty score when
completing the puzzle.

The Hints menu

At the Apprentice skill level, you have
access Lo six types of hints. You can re-
veal a random Single Letter, Single
Consonant, Single Yowel; or vou can
reveal All the vowels or consonants, 11
you are really stumped, vou can select
Whole Word and get on with the rest
ol the puzele.

Score menu

Display Score

Displavs vour eurrent score. The score
display shows total correet words, score
information, penalties associated with
wrong answers and hints, and the adjust-
ed score and percentage of puzzle com-
pleted. Note: The Adjusted Score is
different from the Total Score shown on
the congratulations sereen. The Adjustec
Score does not include time bonuses or
penalties.

The following table represents a break-
down of how your score is computed in
TakeeA=Break! Crosswords.

Puzzle Difficulty
Auvtocheck ON:  Easy Med. Hard
Correct Answer +100 +200 +300-
Wrong Answer : -25 =50 7S
Single Lefter Hints 15 30 45
Single Vowel Hints 20 40 60
Singie Consonant Hints -0 20 -30
All Vowels Hints 60 120 -180
All Consonants Hints 40 -80 -120
Whole Word Hints -100  -200 -300
_Ear[y Fin_ish Eonus :

+1000 +2000 +3000

{per minute}

-500 -1000 -1500

(per minute}




Puzzle Difficulty

Avtocheck OFF: Easy Med. Hard

Correct Answer +200 +400 +600
T — 50 -100 -150
Single Letter Hints -30 60 90
Single Yowel Hints -40  -80 -120
-S;ng_le Cor:so_nc_m}_-li;is -20 _ -40- -60
All VowelsHints ~~~ -120 240 -360
All Consonants Hints -80 1_65 _213

Whole Word Hints =200  -400 -600

Early Finish Bonus

(per minute) +2000 +4000 +6000

Late Finish Penu|_ty_
-1000 -2000 -3000

(per minufe)

Scoring ON/OFF

Turns scoring on or ofl. Scoring is not
available if Autocheck is turned off be-
cause displaying the score would indicare
a correct or incorrect answer. However, il
scoring is turned off you still will be able
to see the final score in the congratula-

tions messa ge.

The Sound menuw

Music and Sound Effects

Turn music or sound effects on or off by
selecting Music or Sound Effects from
the sound menu. An option ison il a
check mark appears beside it. Refer to the
Music & Sound Tffects section on page 15
or the README file on disk lor more
information.

Roland Enhanced Music

Turns Roland Enhanced Music on or
ofl. Refer to the README file on disk
for more detailed information,

The Pavse/Hide menu

Pause your game in progress while
“hiding” {minimizing) vour game screen
10 a Windows Desktop icon. Select the
Pause/Hide option from the Pause/
Hide pulldown menu, or click on the
minimize button on the upper right
hand corner of the TakeeAeBreak!
Crosswords window (indicated by a
downward pointed triangle).

You can choose one of four different
icons 1o display when the game is
paused. These include two “fun” icons
(Crosswords and Wanda), and two “less
conspicuouns” icons entitled [ile (unti-
tled) and Worksheet.

Congratulations!

After you complete a puzzle, a congratu-
lations message appears that displays a
famous fuote, vour final sCoTing infor-
mation, and an animation if you choose.
You may view it again by selecting the
Display Congratulation Screen option
from the Congratulations menu.



GAMEPLAY

Mouse and Keyboard Contrels
You can play TakeedeBreak! Crosswords
with the kevboard only or with a combina-
tion of mouse and kevboard controls.

Mouse Controls

When cursor is over puzzle:

Right mouse button selects
cursor direction (across or down).
Left mouse button is clicked on the
desired puzzle squares to selecr a par-
tienlar word, and to enter an answer.,

When cursor is over Aeross and Down
clue list boxes:

Left mouse button selects a new
clue. You may also seroll through clue
choices with the seroll bar.

Note: The squares of a selected word are
highlighted in yellow, with the current let-
ter’s square highlighted in red.

The active clue list (Aeross or Down) has
a white background with blue letters and a
dark red highlight bar indicating the cur-
rent selection. The inactive list of clues ap-

pears in a darker color.

Keyboard Commands

Most menus and options can be accessed
by pressing [ALT] plus the underlined
letrer in Th(: mMenms.

"ub

Switches between Aeross and Down

clues (as indicated by the current letter
stuare),

. Lnter |

Fnters current guess and advances vou to
the next clue. Note: Il Autochecek is se-
lected you will be advanced to the next in-
correct or in(‘.Omp]E‘l'(‘. \\-’l:l]'d.

;i"i;' Enter |+ Shifl

E:ljll'f_’]"ti current guess and advances vou to
=] 4

the previous clue. Note: If Autocheck is
selected vou will be advanced to the next
incorrect or incomplete word.

Opens the puzzle selection window

(F2

. in order to choose a new puzzle.

Pause/Hide the game.

'F3
S
A -

- Enters your answer into the
| 2]
bt S current letter box.
Noter all cursor keys (and backspace)
retain their usual functions,



Music & Sound Effecis

IH.EPU!’t‘.(ii‘?f:\.v.’;:;&’f"Ml.l:-'_i.i(‘- & Sound effects
are only available with Windows 3.1 or
higher, or with Windows 3.0 with
Multimedia Extensions.

Please refer to the READMIE file included
on the Crosswords disk for detailed
information on how to configure sound
and music for the best possible results on

YO systen,

High Performance Tips
TakeedoRreak! Crosswords contains
many state-ol-the-art features that re-
fuire extra memory and computer pro-
cessing time. If vou wish to reduce the
memory usage or increase the speed of
TakeeAeBreak! Crosstwords, vou may
want tn disable some features that arve

particularly demanding of computer

power. These features include:

256 color artwork (if available)
Interconneeting Clue Highlight
Animations

Music & Sound Effects

Augarde, Tony. The Oxford Guide to
Word Games. Oxford University Press.

Oxlord, England. 1984.

Dauiels, Vera. The Experts’ Book of
Crosstword Puzzle Making. Doubleday
and Company.. Inc. Garden City, New
York. 1976.

Hill. Norman. How to Solve Crossword
Puzzles. Webster's Red Seal Publications
Inc. New York. 1974,

Kennedy, I. Michael =40 million
Americans grapple with *7 across™”

San Jose Mercury News 21, March 1992,
sec, AT.8.

Kurzban, Stan and Rosen, Mel, The
Complete Cruciverbalist; Or How to Solve
Crossword Puzzles for Fun and Profit.
Litton Educational Publishing Ine. New
York. 198"

Millington. Roger. Crossward Przzles:
Their Historyv and Their Cult. Thomas
Nelson Publishers. New York. 1974,
“1942-1992 Fifty Years of Crosswords.”
February 16, 1992, New York Times

Sunday Magazine.
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Technical Help

Technical assistance is only a phone call away. In the
U.S. call (209) 683-8989 for convenient, person-to-
person service, or il you prefer, vou may request
assistance by mail. If you choose to write to us with
vour request, please state your computer type and the
nature ol your problem.

call or write:

Sierra

Technical Support

P.0. Box 800, Coarsegold,

CA 93614-0800 17.8.A.

(209) 683-8989 © fax (209) 683-30633

Our Earopean customers meay call or write onr UK.
aoffice:

Sierra On-Line Limited

Unit 2, Technology Centre,

Station Road,

Theale,Berkshive RGT 4AA United Kingdom
0734-303171

Replacement Disk

I you find that you need to send for replacement
diskettes, send the original disk #1 1o

Sierra

1".00, Box 485, Coarsegold,

CA 930614-0485 UL
At Returns

Be sure to include a note stating vour computer type,
and the size of diskeite you need {5257 or 3.57). We
will gladly replace your program free of charae for the
first 90 days ol ownership (please enclose a copy of
vour dated sales receipr with vour request). After 90
days there is a $10.00 charge for 5.257 or 3.5”
diskettes.

Sierra BBS

If you have a modem, you may aceess the Sierra BBS
for technical assistance, downloadable demos, catalogs.
ete. (parameters: 300/1200/2400/9600 baud up to

V. 42bis, N, 8, 1).

In the 115, call (209) 683-4463.

In the UK. call 0734-304227.

Customer Service

Call or write the Customer Suppert Department with
inquiries about general game information, company
policy, back orders, returned or defective merchandise.
Sierra

Gustomer Support

P.0O. Box 600, Coarsegold.

A 93614-0600

IT1S ILLEGAL TO MAKE UNAUTHORIZED COPIES OF THIS SOFTWARE
I'his software is protected under federal copyright law. It is illegal to make or distribute copies of this soltware except
to make a backup copy for archival purposes only. Duplication of this software for any other reason including for
anle, loan, rental or gift is a federal crime. Penalties include fines as high as $50,000 and ]m] terms of up to five years,

& SIERRA

as a member of the Soliware Publishers Association (SPA}. supports the industry’s effort to fight the illegal copying of
I']f‘-l'sﬂ[]a! l"r}n]f?ll“‘-l' .»G[][IT\'\"}II'[‘.

Report Copyright Violations To:

SPA, 1101 Connecticut Avenue, NW.
Washington, DC 20036

uite 901

Limited Warranty Notice
The publisher of this software wanis vour continued business. If vou [ill out the enclosed product registration card and
return it (o us, you are covered by our warranty. I vour software should fail within 90 davs of purchase. return it 1o
your dealer or directly 1o us, and we will replace it free. Alter 90 days, enclose $10 for 5.25" or 3.5" disks and return
the soltware direetly to us, Sorry, without the regisiration card you are not eoversd by the warranty. This warranty
gives you speeilic legal rights, and you may also have other rights which vary from state to state.

Copyright Nofice
This manual. and the software described in this mannal, are copy righted. All rights are reserved. No part of this manual
or the described soltware may be copied, reproduced, translated or reduced (o any electronic medium or machine-
readable form without the prior written consent of Sierra On-Line, Inc., P.O. Box 485, Coarsegold. CA 93614,






